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Introduction

Welcome to Mac OS X Snow Leopard On Demand, a visual
quick reference book that shows you how to work efficiently
with Apple Mac OS X Snow Leopard.  This book provides
complete coverage of basic to advanced Mac OS X skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Mac OS X Snow Leop-
ard, just look for the icon: New!. The new icon appears in the
table of contents and throughout this book so you can quickly
and easily identify a new or improved feature in Snow Leop-
ard. A complete description of each new feature appears in
the New Features guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
A+P, as a quicker alternative to using the mouse. A complete
list of keyboard shortcuts is available on the Web at 
www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshop

Get More on the Web

www.perspection.com
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ples files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
through out the book. The exam-
ple files that you need for project
tasks along with a complete file
list are available on the Web at
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

www.perspection.com


Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshop. You start each
project with a sample file, work
through the steps, and then com-
pare your results with project
results file at the end. The Work-
shop projects and associated files
are available on the Web at
www.perspection.com.

Get More on the Web
In addition to the information in
this book, you can also get more
information on the Web to help
you get up to speed faster with
Mac OS X. Some of the informa-
tion includes: 

Transition Helpers
◆ Only New Features.

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ Keyboard Shortcuts.

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

The Workshops
walks you through
in-depth projects
to help you put
the Mac OS X
Snow Leopard to
work.

Introduction xxi

Additional
content
is available
on the Web.

www.perspection.com
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More Content
◆ Photographs. Download

photographs and other
graphics to use in your
documents.

◆ More Content. Download
new content developed after
publication, such as a chapter
on Using Basic Unix
Commands.

You can access these additional
resources on the Web at
www.perspection.com.

Download and
use Photographs
to help you add
impact to your
documents.

www.perspection.com


Finding What You Want with
Spotlight

Introduction

If you’re looking for specific content on your computer or net-
work and you don’t know where to find it, you can use
Spotlight to help you locate it. Spotlight not only searches
the names of your files and folders, it also searches their con-
tent. In addition, Spotlight searches other information stored
in files, known as metadata, which describes how and when
and by whom a particular set of data was collected, or how
the data is formatted. Examples of metadata include authors,
page size, creation and modification dates, duration of music
and movies, dimensions of graphics or PDF documents,
exposure time of a camera lens for photographs, and names
of layers in Photoshop.

Spotlight is conveniently located on the right side of the
menu bar on your Mac screen. You can identify Spotlight by
the blue icon with a magnifying glass. Spotlight performs a
live search of your Home folder on your computer using the
information you know. As you type in Spotlight, a menu
appears displaying a list of everything Spotlight can find to
match what you’ve typed so far. As you continue to type, the
list changes. Spotlight searches for everything on your com-
puter that matches what you’ve typed, which includes every
file, folder, program, e-mail message, address book entry,
calendar appointment, picture, movie, PDF document, music
file, Web bookmark, Microsoft Office document, and System
Preferences panel, and lists the 20 best matches divided into
categories, which you can customize later. 

When you start Snow Leopard for the first time, Spotlight
automatically starts collecting search information about your
Home folder, known as indexing. The indexing process ini-
tially takes about 15 to 30 minutes to perform (the Spotlight
icon pulses) and then updates take place as needed. Indexing
the information on your computer reduces the time it takes
to perform a search.

3

3
What You’ll Do

Find Information Using Spotlight

Find Information in the Spotlight
Window

Filter Spotlight Results

Group and Sort Spotlight Results

Work with Spotlight Results

Set Spotlight Preferences

Search for Files Using the Find Window

Search for Hard to Find Information

Work with Find Window Results

Create and Use Smart Folders 

Use Smart Folders in the Sidebar

Get Help While You Work

Get Help Using Spotlight

55



If you’re looking for specific content on your computer and you don’t
know where to find it, you can use Spotlight to help you find it. Even if
you can only remember part of the content. Spotlight performs a live
search of your Home folder on your computer using the information you
know. As you type in Spotlight, a menu appears displaying a list of
everything Spotlight can find to match what you’ve typed so far. As you
continue to type, the list changes. If you type two words, Spotlight finds
items that contain both words. Spotlight searches for everything on
your computer that matches what you’ve typed, which includes every
file, folder, program, e-mail message, address book entry, calendar
appointment, to-do item, picture, movie, PDF document, music file, Web
bookmark, Microsoft Office document, and System Preferences panel,
and lists the 20 best matches divided into categories, which you can
customize later. Spotlight not only searches the names of your files and
folders, it also searches their content. You can search by typing
phrases or metadata attributes, and using boolean operators.

56

Finding Information
Using Spotlight

Find Information Using Spotlight

Click the Spotlight (magnifying-
glass) icon on the right side of the
menu bar.

TIMESAVER Press A+Space
bar to open Spotlight. 

In the Spotlight field, start to type
what you want to find. To find a
specific phrase, place quotes
around it. For example, “Apple
Computer.”

IMPORTANT Spotlight only
recognizes the beginnings of
words.

As you type, a menu begins to
display a list of everything
Spotlight can find to match what
you’ve typed so far. As you
continue to type, the list changes.

To open an item on the menu, click
the item or use the arrow keys to
scroll down the list, and then press
Return.

To clear or stop a search, click the
Close button (x) in the Spotlight
field.

4

3

2

1 12

4

3
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Find Information with Metadata
Using Spotlight

Click the Spotlight (magnifying-
glass) icon on the right side of the
menu bar.

TIMESAVER Press A+Space
bar to open Spotlight. 

In the Spotlight field, type
code:keyword. Use quotation
marks around text to search for an
exact phrase.

Where the code is a category, such
as kind, date, modified, or author,
and keyword is a specific type of
category.

Here are some examples:

◆ kind:preference network
displays the network system
preference on your computer. 

◆ kind:contact steve displays all
the contacts with the name
steve on your computer. 

◆ kind:music by:”Bruce
Springsteen” displays all music
by Bruce Springsteen.

◆ date:today kind:email displays
all the email for today on your
computer. 

2

1

Did You Know?
You can quickly cancel a Spotlight
search. Press the Esc key to close the
Spotlight menu and erase what you’ve
typed. Now, you can type a new
search. Press the Esc key again to
cancel the entire search. To cancel the
entire search in one step, press
A+Space bar again, A+period, or
A+Esc.

Using Boolean Operators to Help Your Search

If you can’t find the information you are looking for using the Spotlight
field or Search field, you can use boolean operators (AND, OR, NOT,
and dash (-) for AND NOT to exclude items) to refine your help search.
For example, typing report AND proposal finds both words, typing
report OR proposal finds either report or proposal, while typing report
NOT proposal finds report, but excludes proposal. If you type report -
proposal, Spotlight finds report but not proposal. You can also use key-
words in your search with boolean operators. For example, typing
kind:pdf report AND kind:presentation proposal, finds PDF documents
with report and presentation files with proposal.

For Your Information

Find Code:Keyword

Program kind:app, kind:application

Address book contact kind:contact

Folder kind:folder

Mail message kind:email, kind:mail message

iCal appointment kind:event

iCal task kind:to do, kind:todo

Image, picture kind:image

Movie kind:movie

Music or Sound kind:music, kind:audio

PDF file kind:pdf

System Preference kind:preference, kind:system preference

Safari bookmark kind:bookmark

Font kind:font

Presentation kind:presentation

Week date:this week, date:next week

Month date:this month, date:next month

Year date:this year, date:next year

Today date:today

Tomorrow date:tomorrow

Yesterday date:yesterday

Find Code and Keywords



If you can’t find what you’re looking for on the Spotlight menu with the
20 most likely matches, you can click the Show All command at the top
of the Spotlight menu to open the Spotlight window and view the com-
plete list of matches organized by category. The Show All command
displays the results of your search by retrieving content on your entire
computer that matches the criteria. The Search bar, located below the
toolbar, indicates the search location and type, which is “This Mac”
and “Contents” by default. You can search your entire computer (This
Mac), your Home folder, or shared network computer by either the con-
tents of a file or the file name.
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Finding Information 
in the Spotlight
Window

Open and View the Spotlight
Window to Locate Information

Click the Spotlight (magnifying-
glass) icon on the right side of the
menu bar.

TIMESAVER Press
Option+A+Space bar to open
Spotlight window directly. 

In the Spotlight field, start to type
what you want to find. 

Click Show All on the Spotlight
menu.

The Spotlight window opens,
displaying the results of your
search by category.

If a search is currently in progress,
a sprocket icon whirls around in
the upper-left corner of the
window. 

To narrow or change the search,
type the text you want to find in
the Search field. 

To open an item, double-click the
item or use the arrow keys to
scroll down the list, and then press
Return.

To clear or stop a search, click the
Close button (x) in the Search
field.

When you’re done, click the Close
button.

7
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Narrow Results in the Spotlight
Window

Press Option+A+Space bar or
click Show All on the Spotlight
menu to open the Spotlight
window.

The Spotlight window opens,
displaying the results of your
search by category.

If a search is currently in progress,
a sprocket icon whirls around in
the upper-left corner of the
window. 

In the Search bar, click the button
with the search location you want:

◆ Servers. Searches the server
disks connected to your
computer.

◆ Computer. Searches all the
disks on your computer.

◆ Home. Searches your Home
folder.

◆ Volume “Hard Disk” or Folder
“Name.” Searches only the
currently opened volume or
folder.

◆ Contents or File Name.
Searches file contents or file
name.

To narrow or change the search,
type the text you want to find in
the Search field. 

To open an item, double-click the
item or use the arrow keys to
scroll down the list, and then press
Return.

To clear or stop a search, click the
Close button (x) in the Search
field.

When you’re done, click the Close
button.

6

5

4

3

2
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3
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Searching Made Easy

You can add text to the Spotlight Comments field in the Get Info dialog
for a specific file or folder that you can quickly search for using
Spotlight later. Control-click a file or folder, click Get Info, and then
type the text you want in the Spotlight Comments field. 

For Your Information
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If the list of Spotlight results is too long to find the results you want, you
can revise your search text in the Search field or use the Search bar to
filter, or narrow down, the list. The Search bar allows you to filter down
the Spotlight results by location and type. The left side of the Search
bar provides buttons to filter the search results by where the informa-
tion is stored, such as This Mac (your entire computer), SteveJ (your
Home folder), or Shared (your networked computers), if available. After
you select where, you can select how. You can filter the result by
whether the search criteria is in the content of a file or the file name of
the results. If you want to further narrow down the Spotlight results,
you can add other search criteria using file attributes.

Filtering Spotlight
Results

Filter Spotlight Results

Press Option+A+Space bar or
click Show All on the Spotlight
menu to open the Spotlight
window, and then perform or
narrow a search.

The Spotlight window displays the
results of your search by category.

In the Search bar, click the button
with the search location you want:

◆ Servers. Searches the server
disks connected to your
computer.

◆ Computer. Searches all the
disks on your computer.

◆ Home. Searches your Home
folder.

◆ Volume “Hard Disk” or Folder
“Name.” Searches only the
currently opened volume or
folder.

The Computer command displays
or restores the full results list on
all your drives in the Spotlight
window.

In the Search bar, click Contents
or File Name to specify how you
want the results to appear.

When you’re done, click the Close
button.

4

3

2

1
2 3

4 Filtered results
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Change Spotlight Criteria in the
Spotlight Window

Press Option+A+Space bar or
click Show All on the Spotlight
menu to open the Spotlight
window.

The Spotlight window opens,
displaying the results of your
search by category.

If a search is currently in progress,
a sprocket icon whirls around in
the upper-left corner of the
window. 

Click the Action button, and then
click Show Search Criteria.

The Spotlight items option appears
in the first Search pop-up,
indicating Spotlight results in the
window.  

Click the Add (+) button, and then
specify the criteria you want.

Click the first Search pop-up of the
second criteria item, and then
select or type the search criteria.

◆ Select Other on the pop-up to
display a complete list of
searchable attributes.

Click the second Search pop-up of
the second criteria item, and then
select or type more specific
search criteria.

To remove search criteria, click
the Remove (-) button.

Click the Action button, and then
click Hide Search Criteria.

To clear or stop a search, click the
Close button (x) in the Search
field.

When you’re done, click the Close
button.

9

8

7

6

5
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59 4 2

Other
available
search
criteria
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After you perform a search using the Spotlight window, you can use the
Keep Arranged By (New!) submenu on the Action menu or the column
header button in List or Cover Flow view to group and sort the results of
your search to make it easier to find what you’re looking for. Clicking on
one of the column header buttons (such as Name, Date Modified, Date
Created, Last Opened, Size, Kind, or Label (New!)) in the search result
window in either List or Cover Flow view, sorts the files and folders by
the type of information listed in the column. If the columns are not
organized in the order you want, you can use the mouse to quickly drag
a column header to rearrange them.

Grouping and Sorting
Spotlight Results

Group and Sort Spotlight Results

Press Option+A+Space bar or
click Show All on the Spotlight
menu to open the Spotlight
window, and then perform or
narrow a search.

The Spotlight window displays the
results of your search by category.

Click the List View or Cover Flow
button on the toolbar to display the
search results in list form.

Click a column header name to
sort the file and folder in
ascending or descending order:

◆ Name. List in alphabetical order
by element name.

◆ Date Modified. List by the date
you last modified it.

◆ Date Created. List by the date
you created it.

◆ Size. List by size.

◆ Kind. List by kind of item,
including applications,
documents, or images.

◆ Label. List by color label.

To change the view options, click
the Action button, click Show
View Options, select options, and
then click the Close button.

When you’re done, click the Close
button.

5

4

3

2

1
325 4

Select view options for
Spotlight search results
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After you perform a search using the Spotlight window, you can
Control-click an item to display a shortcut menu and get more informa-
tion about an item in the Spotlight results. When you Control-click an
item, the shortcut menu allows you to open the item, get information
about the item from the Get Info dialog box, locate the item in the
Finder, display a slide show for graphic items, or create an e-mail with
attachments using Mail.

Working with
Spotlight Results

Work with Spotlight Results

Press Option+A+Space bar or
click Show All on the Spotlight
menu to open the Spotlight
window, and then perform or
narrow a search.

The Spotlight window displays the
results of your search by category.

Option-click the item(s) you want,
and then click the option you want:

◆ Open. Opens the selected
item(s).

◆ Open Enclosing Folder.
Displays the selected item(s) in
a Finder window.

◆ Get Info. Opens the Get Info
dialog box with basic file infor-
mation for the selected item(s).

◆ Quick Look. View the contents
of a file or folder without
opening it.

◆ Mail. Point to Open With to
open an e-mail message with
the selected item(s) as
attachments.

When you’re done, click the Close
button.

3

2

1 3 2



You can change Spotlight preferences to customize the way you use
Spotlight. You can specify the categories, such as Applications,
Documents, Folders, and so on, you want or don’t want to include in a
Spotlight search. In addition, you can change the order of the cate-
gories to prioritize the way the results appears. If you prefer different
shortcut keys to display the Spotlight menu or open the Spotlight win-
dow, you can change them. When Spotlight performs a search, it looks
every where on your computer (except for someone else’s Home
folder). If you want to keep certain disks, partitions, or folders private,
you can add them to your privacy settings in Spotlight preferences.
When you add an item to the privacy list, Spotlight removes them from
the Spotlight index.
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Setting Spotlight
Preferences

Set Spotlight Search Results
Preferences

Click the System Preferences icon
in the Dock, and then click the
Spotlight icon.

TIMESAVER Click Spotlight
preferences at the bottom of the
Spotlight menu (after you’ve
started a search).

Click the Search Results tab.

Select the check boxes you want
to include in the search results or
clear the check boxes you don’t
want to include in the search
results.

To change the order to the search
results categories, drag the
categories to the location you
want.

Click the Close button.5

4

3

2

1

2

3

5

Did You Know?
You can use Spotlight everywhere
(almost). The Spotlight Search field is
also available in the Finder, Mail,
System Preferences, and Open and
Save dialogs to name a few.

Selecting the Default Search Location

You can specify the default search location for Spotlight (New!).
Click the Finder menu, click Preferences, click Advanced, click the
When performing a search pop-up, then click Search This Mac,
Search the Current Folder, or Use the Previous Search Scope.

For Your Information

4
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Set Spotlight Privacy
Preferences

Click the System Preferences icon
in the Dock, and then click the
Spotlight icon.

Click the Privacy tab.

Drag the items (disks, partitions, or
folders) to the list of non-
searchable items from the
desktop, or click the Add (+)
button, navigate to the item, and
then click Choose.

To delete an item, click the item,
and then press Delete or click the
Remove (-) button.

Click the Close button.

Set Keyboard Shortcuts for
Spotlight

Click the System Preferences icon
in the Dock, and then click the
Spotlight icon.

Select the Spotlight menu
keyboard shortcut check box, click
the list arrow, and then select the
shortcut you want.

Select the Spotlight window
keyboard shortcut check box, click
the list arrow, and then select the
shortcut you want.

Click the Close button.4

3
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Searching for Files
Using the Find 
Window

Search for Files Using the Find
Window

Open a Finder window, and then
display a drive or folder if you
want to narrow the search.

Click the File menu, and then click
Find.

TIMESAVER Press A+F to
open the Find window.

◆ You can also use the Search
field located in every Finder
window.

In the Search field, type the text in
which you want to search.

Click the button with the search
location you want:

◆ Servers. Searches the server
disks connected to your
computer.

◆ Computer. Searches all the
disks on your computer.

◆ Home. Searches your Home
folder.

◆ Volume “Hard Disk” or Folder
“Name.” Searches only the
currently opened volume or
folder.

◆ Contents or File Name.
Searches criteria by  file
contents or file name.

4

3

2

1

Spotlight provides a quick and easy way to search for files, but if you
need to perform a more specific search, the Find window can help you
search for what you need. The Find window lets you specify where and
how you want to search—Servers, Computer (everywhere), Home, or
Shared, and Contents or File Name. You can also narrow your search
by selecting or typing a specific list of criteria—such as name, loca-
tion, size, kind, color label, extension, type, and by creation or last mod-
ification date—available in the Find window. For example, you can
search for all graphic files with the .jpg extension you created last
month that contain web. After you complete a search, a separate
results window opens. Unlike the Spotlight, you can change the criteria
and perform a new search, and then compare the results. 

31
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Click the first Search pop-up, and
then select or type the search
criteria; options vary depending on
the criteria.

◆ Kind. Finds files that are or
aren’t a certain kind.

◆ Last Opened. Finds files that
you last opened.

◆ Last Modified. Finds files
according to the date modified.

◆ Created. Finds files according
to the date created.

◆ Keywords. Finds files according
to words and phrases.

◆ Color Label. Finds files
according to label color.

◆ Name. Finds all or part of a file
name (capitalization doesn’t
matter); select another option,
such as Contains, Starts With,
Ends With, or Is.

◆ Contents. Finds words inside
your file; handy if you don’t
remember the name.

◆ Size. Finds files based on size,
such as Equal to, Greater than,
or Less than.

◆ Other. Finds files based on
other attributes.

Click the second Search pop-up,
and then select or type more
specific search criteria.

To add search criteria, click the
Add (+) button, and then specify
the criteria you want.

To remove search criteria, click
the Remove (-) button.

The search results appear in the
window.

To pause or stop a search in
progress, click the X button.

9

8

7

6

5 6

7

5

9
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Setting a Search Location Preference

In the Finder Preferences dialog, you can specify a search location
preference (New!). You can select any of the following options:
Search This Mac, Search the Current Folder, or Use the Previous
Search Scope. Click the Finder menu, click Preferences, click
Advanced, click the When performing a search pop-up, and then
select the option you want.

For Your Information
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In addition to searching for typical information, such as name, location,
size, or kind, you can also search for file specific metadata, such as
visibility (visible files, not hidden one used by Mac OS X), duration,
dimensions, pixel height and width, device make, and layers. There are
over 115 different metadata search attributes from which to choose. For
example, you can select search attributes to find visible files (not hid-
den ones used by Mac OS X), the duration of music and movies, the
dimensions of graphics or PDF documents, the device used to acquire
a document, and the names of layers in Photoshop.

Searching for Hard to
Find Information

Search for Hard to Find
Information

In the Finder, click the File menu,
and then click Find.

TIMESAVER Press A+F to
open the Find window.

◆ You can also use the Search
field located in every Finder
window.

In the Search field, type the text in
which you want to search.

At the top of the window, click the
button with the search location
you want: Servers, Computer,
Home, Volume or Folder, and
Contents or File Name.

Click the first Search pop-up, and
then click Other.

Select the search attribute you
want to find.

Click OK.6
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After you perform a search with the Find window, you can perform a
variety of file management operations directly with the Find window
results, which are similar to the ones you can perform in the Finder. For
example, you can get file information, and move, copy, rename, or
delete a file directly in the search results window. In addition, you can
display the location of a file in the search results window, and then
open its folder location or open the file. 

Working with Find
Window Results

Work with Find Window Results

After you perform a search with the
Find window, you can use the following
options to work with the results:

◆ Find the location of a file. Click a
file to display the location in the
Path bar at bottom of the window.

◆ Open the location of a file. Click
the File menu, and then click Open
Enclosed Folder.

◆ Open a file. Double-click the file
icon.

◆ Move or delete a file. Drag the file
to a new location or the Trash.

◆ Rename a file. Click its name,
select the text, and then type a
new name.

◆ Copy a file. Use the Copy and
Paste commands on the Edit
menu.

◆ Get file information. Click the File
menu, and then click Get Info. Add
criteria to Spotlight Comments for
use in Spotlight searches. 

◆ Sort the result by category. Click
the column header.

◆ Start a new search. Change the
text in the Search field, or click the
Close (x) button in the Search field
and type a new search.

◆ Close the search. Click the Close
button or press A+W.

Path bar

Double-click to open Click column to sort

Get info 
spotlight comments
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A Smart folder is a self-updating folder that performs a search based
on the search criteria you set and save in the Search dialog box. You
can create a Smart folder by specifying a search in the Search dialog
box and then saving it as a saved search. For example, if you set up a
search for Last Opened and This week, and saved it as a Smart folder.
When you double-clicked the Smart folder, it opens displaying the files
you’re currently working on.

Creating and Using
Smart Folders

Create and Use a Smart Folder

Click the File menu, and then click
New Smart Folder.

Use the Add (+) button to specify
the search criteria you want to
save as a Smart folder.

Click the Save button.

Type a name for the Smart folder.

Specify the location where you
want to save the Smart folder. 

The default location is the Saved
Searches folder.

Select or clear the Add To Sidebar
check box to either add or not add
the Smart folder to the sidebar.

Click Save.

To use a Smart folder, click the
Smart folder icon on the Sidebar,
or navigate to the Saved Searches
folder, and then double-click it.

◆ The Saved Searches folder is
located in the Library folder,
which is located in the Home
folder.
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Smart
folder

Did You Know?
You can open a recent item. Click the
Apple menu, point to Recent Items, and
then click the recently used document
you want to open. 
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Edit a Smart Folder

Navigate to the Smart folder you
want to edit; double-click 
the folder in the Smart folder to
open it.

◆ The Smart folder is located in
the Saved Searches folder in
the Library folder, which is
located in the Home folder.

◆ You can also use the Sidebar to
select a Smart folder.

Click the Action menu, and then
click Show Search Criteria.

Change the search criteria you
want to modify.

Click Save.

Click the Action menu, and then
click Hide Search Criteria.
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Did You Know?
You can save a copy of a Smart folder.
If you have a Smart folder similar to the
one you want to create, you can go to
the Smart folder and then make a copy
of the Smart folder you want. After you
make a copy, open it and make the
changes you want, and then click
Save.

You can delete a Smart folder. Open
the Smart folder, and then drag the
Smart folder you want to delete to the
Trash icon. 

Where’s the Smart folder? The Smart
folder is located in the Saved Searches
folder in the Library folder, which is
located in the Home folder. 
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The Sidebar appears in every Finder window. At the bottom of the
Sidebar, the Search For section displays icons for Smart folders, which
is a self-updating folder that performs a search based on the search
criteria. The default Smart folder icons include Today, Yesterday, Past
Week, All Images, All Movies, and All Documents. You can add your
own Smart folders to the Sidebar or modify the ones already on the
Sidebar.

Using Smart Folders 
in the Sidebar

Use Smart Folders in the
Sidebar

Open a Finder window.

Under the Search For heading in
the Sidebar, click one of the
following options:

◆ Today.

◆ Yesterday.

◆ Past Week.

◆ All Images.

◆ All Movies.

◆ All Document.

2

1

2
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Change the Search Criteria for a
Smart Folder in the Sidebar

Open a Finder window.

Under the Search For heading in
the Sidebar, click the Smart folder
icon you want to view.

Click the Action menu, and then
click Show Search Criteria.

Specify the search criteria you
want to save for the Smart folder.

Click the Save button.

Click the Action menu, and then
click Hide Search Criteria.
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See Also
See “Creating and Using Smart
Folders” on page 70  for information on
adding a Smart folder to the Sidebar.

Did You Know?
You can add a Smart folder or other
folder to the Sidebar. Select the folder
in a Finder window or desktop, click
the File menu, and then click Add To
Sidebar.
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When you have a question about how to do something in Mac OS X, you
can usually find the answer with several clicks of your mouse. Mac OS
X Help is a resource of information to help you use Mac OS X. The Mac
OS X Help is like an online book with a table of contents, complete with
a search feature, and additional links to the Internet to make finding
information a little bit easier. You can access help from the Help menu in
the Finder as well as many other Mac OS X applications, such as Safari
and iChat; you can even switch between the different help libraries
using the Home button. If you see the Help button (question mark) in a
window or dialog, you can click it to get feature related help. If you have
an Internet connection, Help retrieves online updates to Mac OS X Help
content as necessary. For additional help and support information, visit
the Apple Computer Web site at www.apple.com.

Getting Help While
You Work

Browse for Help Information

In the Finder, or any other
application, click the Help menu,
and then click Mac Help or Help
<application name>.

To select another Help, click and
hold the Home button, and then
click a help library.

Click a link in the Help window
until you find the topic with the
information you’re looking for.

Use the Help toolbar to
navigation help topics:

◆ Click the Home button to return
to the first page of the help. 

◆ Click the Back and Forward
button to view previously
viewed topics.

◆ Click the Index link to display
an index like the back of this
book. Click a letter to narrow
the list, and then click the topic
you want to display. Click the
Home link to display the first
page of the help.

Click the Close button to quit
Help.
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Search for Help Information

In the Finder, or any other
application, click the Help menu,
and then click Mac Help or Help
<application name>.

Click the magnifying glass in the
Search field, and then click
Search Mac Help or Search All
Help.

Click in the Search field.

TIMESAVER Press the Tab key
to quickly go to the Search field.

Type the words you want to find
in the help topics, and then press
Return.

A list of matches appears with a
Relevance column ranking the
results by percentage.

Double-click the topic you want
to read in the search results list.

Use the navigation buttons (Back
and Forward) on the Help toolbar
to move between help topics.

Click the Close button to quit
Help.
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Did You Know?
You can start a new search in a new
window. Click the File menu, click
New, and then perform a new search.

You can print a help topic. Display the
help topic in the Help window, click the
Action button on the Help toolbar, click
Print, and then click Print again.

You can change the size of Help text.
Click the Action button on the Help
toolbar, click Make Text Smaller or
Make Text Bigger.
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In addition to using Spotlight to find files and other information on your
computer, you can also use Spotlight to quickly find help information.
When you click the Help menu, the Spotlight Search field appears at
the top, where you can type the help information you want to find and
display. You can access help from the Help menu in the Finder as well
as many other Mac OS X applications, such as Safari and iChat. When
you select a help topic from the Help menu, the Help window appears
displaying the topic. If you want to display all the related help topics,
click Show All Results. A complete search results appears, where you
can double-click a topic to display it. If available, menu items appear on
the Help menu, where you can select it to display an blue arrow point-
ing to the location of the menu.

Getting Help Using
Spotlight

Get Help Using Spotlight

Click the Help menu.

In the Spotlight Search field, start
to type what you want to find. To
find a specific phrase, place
quotes around it. For example,
“Spotlight”

As you type, a menu begins to
display a list of everything
Spotlight can find in Help to match
what you’ve typed so far. As you
continue to type, the list changes.

On the Help menu, select one of
the following options:

◆ Display a Help Topic. Click the
Help topic item or use the
arrow keys to scroll down the
list, and then press Return to
open the Help window.

◆ Show All Results. Click Show
All Results to display the
search results for help topics,
and then double-click the topic
you want to open the Help
window.

◆ Display a Menu Item. Point to
the Menu item name to display
a blue arrow pointing to the
location of the menu item.

Click the Close button to quit
Help.

4

3

2

1
1 2Display menu item 3

Show all
results
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Index

A
Abstract Background, 102
Access Control Lists (ACLs), 478
accounts. See also Mail

iChat accounts, creating, 290-291
Acrobat Reader. See also PDF files

downloading, 209
actions. See Automator
ActionScripting, 507
activating/deactivating

fonts, 154-155
login window, 387
windows, 12-13

Activity Monitor, 444-445
Address Book, 129, 130. See also iSync

archiving data, 139
Bluetooth with, 412
creating, 138-139
Dashboard displaying, 158-159
Directory for sharing information, 143
editing contact information, 140-141
faxes, addressing, 214, 218
iChat buddies from, 296
images, adding, 144
managing contacts, 142
MobileMe Address Book, 350-351
pictures to contacts, adding, 144
printing from, 141
Safari Bookmarks bar, adding to, 238-239
sending e-mail from, 266-267
sharing, 142-143
Smart Addresses, using, 266
Spotlight searches, keywords for, 57
subscribing to, 143
vCards, 139, 142-143

Administrator, 386

file permissions, setting, 390
master password, restoring, 398-399
Safari preferences, setting, 253
in Simple Finder, 94

Adobe Acrobat. See also PDF files
downloading, 209

AIM, iChat with, 289, 291
AirPort

Admin Utility, 430
configuring connection, 220
desktop icon, 5
iChat with, 308
with Mac for Windows, 465, 472
making Internet connection with, 226
multiple connections with, 221
network port configuration for, 225
printers, sharing, 202-203
setting up, 224

AirPort Extreme Base Station, 481
alerts

changing sounds, 114
forms, sending nonsecure, 243
iChat notification alerts, 312
speaking voice for, 118

Alex
default speaking voice, setting, 118
interface options, setting, 119
for VoiceOver, 122

aliases, 77, 395
creating, 90-91

alignment
of document text, 178
of e-mail message text, 269
of tables, 185

AND operator, searching with, 57
animated GIFs

creating, 297
movies as animated GIFs, exporting, 331
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anti-aliasing, 100-101
Anywhere mode, 168
AOL and iChat, 219, 289-290
appearance options, changing, 100-101
Apple Account number for iTunes Music

Store, 318
Apple Background, 102
Apple Developer Connection Web site, 162
Apple Events, sharing, 405
Apple Mighty Mouse, 6

Dashboard preferences, changing, 157
with Mac for Windows, 472

Apple Remote, 465. See also Front Row
iPod Hi-Fi, 313
with Mac for Windows, 465, 472

AppleScripts, 130
with Automator, 512
basics of, 507
displaying Script menu, 508
example Scripts folder, opening, 509
opening from Scripts menu, 511
ready-make AppleScripts, using, 508-509
recording, 510
writing, 510

AppleTalk printers, installing, 198-199
applications, 1, 129. See also aliases; third-

party applications
different program, opening documents

with, 29
icons, 10
Info window, information in, 50-51
installing third-party applications, 131
launching, 132
list of, 130
nonresponding, quitting, 136
opening, 133
quitting, 136
showing/hiding, 134
Spotlight searches, keywords for, 57
switching between, 134-135
System Profiler, viewing system infor-

mation with, 447
Application Services, using, 436
Applications folder, 26-27
archiving. See also backing up

Address Book data, 139
Create Archive command, 435
e-mail, 281

ARPANET (Advanced Research Projects
Agency Network), 219

Arrange menu in Icon view, 32
arrows in dialogs, 9
Assist Me, help with, 407
attachments

deleting from e-mail, 277
iCal calendar event attachments, work-

ing with, 370
with instant messages, 303
in replies to e-mail, 275
saving files, 277
sending files as, 276
Spotlight results as, 63
viewing, 276-277

audio chats. See iChat
audio MIDI devices, configuring, 460-461
authentication preferences for Bluetooth,

415
AutoFill for Safari forms, 242
Automator, 130, 491

Action list, 492, 494
actions, 491

adding, 500
recording actions, 502
variables to action, adding, 501

AppleScripts with, 512
Description view, 493, 494
example workflow

modifying, 499
opening, 497
working with, 498

existing workflow, opening, 496
input and output, controlling, 499
introduction to, 492-493
Library pane, 492, 494
modifying example workflow, 499
plug-ins with, 499, 506
printing workflow, 505
recording actions, 502
running and saving workflows, 504-505
Search box, 493, 494
starting, 495
stopping workflow, 504
toolbars, 492, 494

customizing, 505
Variable list, 492-493, 494
variables to action, adding, 501
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Watch Me Do action, 502
window, parts of, 492-494
Workflow log and panes, 493, 494
Workflow variable list, 493, 494
working with workflows, 503

autosaving TextEdit preferences, 194

B
Back button on toolbar, 17
backdrops in Photo Booth, 331
backgrounds

desktop backgrounds, selecting, 102
in e-mail message text, 269
iChat window background, changing, 311

backing up, 477. See also archiving; disk
image; Time Machine

on CDs or DVDs, 490
compressed files and folders, 435
e-mail, 281
formatting, backups prior to, 438
iCal calendar, 371
to iDisk, 479
iTunes library, 327
MobileMe, backing up files, 358-359

Back to My Mac, accessing computer with,
420-421

baseline for characters, changing, 182
BBEdit, 436
BinHex format, 251
birthday calendars, 369
blocking

e-mail, 284-285
iChat buddies, 302
pop-up windows, 255

Bluetooth. See also iSync
Application Services with, 436
desktop icon, 5
with Mac for Windows, 465, 472-473
making Internet connection with, 226
moving items with, 414
Passkey with, 413
preferences, setting, 415
printers, installing, 199
setting up network, 412-413
sharing, 405

boldfacing
document text, 178

e-mail message text, 269
fonts, 155

Bonjour, 289
list of Web sites, viewing, 238
printers

installing, 198-199
sharing, 202-203

problems with, 308
saving chats, 311
starting messaging, 309
turning on, 308

bookmarks. See also Safari
with DVD Player, 333

Bookmarks Library. See Safari
Boolean operators with Spotlight search, 57
Boot Camp Assistant, 112, 465. See also

Mac for Windows
installing Windows on Mac, 468-469
preparing Mac for Windows, 466-467
removing Windows with, 474-475
upgrading from beta, 467

BOOTP (boot protocol), 223
borders for table cells, 185
bouncing e-mail, 284-285
Braille, VoiceOver supporting, 122, 125
brightness on monitor, changing, 454
broadband connection. See cable modems
browsers. See Web browsers
buddies. See iChat
bulleted lists, 184

in e-mail message text, 269
burning. See CDs; DVDs
Business, Dashboard displaying, 158-159
.bzip files, opening, 434

C
cable modems, 220

Ethernet with, 223
firewalls for, 409
sharing connection, 408

cache
for e-mail, 260
Safari cache, emptying, 236

calculations. See also Calculator
Grapher, creating graphs with, 145

Calculator, 130
conversions, performing, 146-147
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Calculator (continued)
Dashboard displaying, 158-159
working with, 146

CalDAV workplace calendar server, 372-373
calendars. See iCal; iSync
cards. See also vCards
case-sensitivity

for finding/replacing text, 176
of passwords, 3

CD-ROMs, 27
CD-Rs, 27
CD-RWs, 27, 52
CDs. See also iTunes

adding/removing files/folders from, 53
backing up files on, burning, 490
creating, 53
disk image, burning from, 488
erasing, 338
music CDs, burning, 326
preparing to burn, 52
Sidebar, burning disk with, 16
start settings, changing, 113
System Profiler, viewing information

with, 447
uneven CDs, loading, 27

Cellos voice, 118
cell phones. See also iSync

Bluetooth preferences, setting, 415
iPhones with iTunes, 325

cells in tables, 184-185
center-alignment

of document text, 178
of tables, 184

change of address notification, 138
characters

baseline, changing, 182
for file names, 42
spacing, changing, 182
special characters, inserting, 188

check boxes in dialogs, 9
check marks in menus, 7
Chess, 129, 137
children. See parental controls
Chinese handwriting, 169
cleaning up

files and folders set by clean up, 33
Icon view, items in, 32-33

clicking with mouse, 6

Clipboard
document text on, 166-167
Web page text, copying, 249

Close button for windows, 12
closed captioning in QuickTime Player, 335
closing

dialog options, 9
documents, 191
windows, 12-13

collating print output, 206
color labels

for files and folders, 40-41
for Find window searches, 67
names, changing, 41

Color Picker, selecting with, 457
colors. See also ColorSync

Color Picker, selecting with, 457
Digital Color meter, using, 456
for document text, 178
with DVD Player, 333
for e-mail message text, 269
for fonts, 155
highlight colors, changing, 100
for iChat chats, 310
for instant message text, 300-301
monitor options, 454
palettes, selecting, 457-458
printer speed and, 196
printing, matching for, 207
for quoted text, 274
of Sticky Notes, 152

ColorSync
for fax documents, 216
matching colors to device with, 458-459
for printed documents, 207

columns. See also List view; tables
windows, headings for, 12

Column view, 30
customizing window views, 82-83
keyboard options in, 37
Preview column, 37
viewing folders in, 37

Comic Book effect, 331
commands, 7. See also specific commands

Startup commands, 395, 399
VoiceOver commands, 126-127

comments
Info window options, 51
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in Keychain, 382
compatibility of hardware devices, 462
compressing/uncompressing

attachments, files for, 276
compressed files, 435
downloaded applications, 131
files and folders, 33
restoring compressed files, 435
Safari, disk images in, 251
Stuffit Expander, opening compressed

files with, 33, 131, 434
computers. See also networks

Find window searching, 66
iTunes, authorizing/deauthorizing, 314
local name, changing, 405
maintaining, 431
several computers, connecting, 418-419
stand-alone computers, starting on, 2

Console utility, viewing system messages
with, 446

contacts. See Address Book
contents, Find window searches by, 67
contextual menus, 8
conversions with Calculator, performing,

146-147
cookies, 254

deleting, 256
cool genie effect, 89
copies for printing, 206
Copy command, 44
copying. See also drag-and-drop

Automator workflows, 503
documents, text in, 167
with Exposé, 45
files and folders, 44-45
Find window files, 69
formatting, 187
hard disk, 439
icons, 10-11
ruler, 179
Sidebar, copying folders with, 16
Web page text, 249
Windows and Mac OS X, files between,

472-473
copyrights

documents, inserting in symbol in, 188
iTunes and, 321
spacing for symbol, 182

Web page text, copying, 249
Corel WordPerfect Page Setup, 204-205
Cover Flow, 30

customizing window views, 82-83
iTunes, working with music in, 317
viewing files in, 36

cover pages, creating, 207, 213
CPU activity, viewing, 445
Create Archive command, 435
credit cards

for iTunes Music Store, 317-318
for MobileMe services purchases, 344

CSS, 162
currency conversions, calculating, 146-147
Customize Toolbar dialog, 84-85
customizing

Automator toolbars, 505
Dock, 88-89
DVD Player, 333
Exposé, 92
fonts, 154-155
keyboard shortcuts, 453
QuickTime Player, 334-335
RSS feeds, 240
Safari window, 228
Sidebar, 86-87
Spaces, 93
views, 30
widgets, 161

Cut command, 44

D
Dashboard, 130

deleting widgets, 160-161
installing widgets, 160
preferences, changing, 157
pre-installed widgets, using, 158-159
showing/hiding widgets on, 158
Web Clip widget, creating, 162
working with, 156

Dashcode, 162
data detector, 171
dates and times

announcing, 105
files and folders arranged by, 33
international options, changing, 106-107
menu bar clock, using, 105
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dates and times (continued)
setting, 104-105
showing, 105
Spotlight searches, keywords for, 57
time zones, setting, 104
World Clock, displaying, 158-159

deleting. See also Dock; iChat; Mail; Safari
Address Book contacts, 140-141
aliases, 90
attachments from e-mail, 277
Automator workflows, 503
Dashboard widgets, 161
documents, text in, 166
downloaded file, 251
e-mail, 280-281
files and folders, 48
hardware devices, 463
iCal events, 370
iSync, devices from, 375
Keychain names, 381
List view, columns in, 35
printers, 198-199
print queue, job from, 211
recently used documents, 165
Safari History list entries, 236
securely deleting files and folders, 49
stacks from Dock, 19
third-party preferences, 97
toolbar icons, 85
user accounts, 389

Description view on Automator, 493, 494
design themes, 5
desktop. See also icons

backgrounds, selecting, 102
introduction to, 4-5
screen, 2

Desktop folder, 28-29
desktop printers, using, 210
Development menu, Safari, 253
Devices section, Sidebar, 16
DHCP (Dynamic Host Configuration

Protocol), 223
dialogs

closing options, 9
language options, setting, 106-107
navigating in, 9

dial-up connections, 222
Dictionary, 130, 163. See also spell and

grammar checking
adding words to, 172
AppleScript dictionary, Automator, 512
Dashboard displaying, 158-159
looking up words with, 174
parental controls, setting, 175
preferences, setting, 174-175
recent searches, viewing, 175

Digital 8 camcorders with iMovie, 342
digital cameras. See Image Capture; iPhoto
digital certificates with Keychain, 381
Digital Color meter, 456
digital hub, 365
Digital Video (DV) camcorders, 291
Directory, 130

Address Book information, sharing, 143
disabled persons. See Universal Access
disk file system, 437

activities, monitoring, 444-445
Console, viewing system messages with,

446-447
copying disk, 439
formatting disks, 438
optimizing disk, 441
problems, fixing, 440
System Profiler, viewing system infor-

mation with, 447
disk image

blank disk image as backup, 487
burning CD/DVD from, 488
creating, 486-487
restoring to disk, 489

disks. See also disk file system; hard drive
ejecting disks, 54
mounting disks, 54
opening/viewing, 26-27

Disk Utility, 52. See also backing up; disk
file system

copying disk, 439
formatting disks, 438
restoring disk images with, 489
Windows, removing, 474-475

.dmg file format, 434
DNS (Domain Name Server), 220

for modems, 222
Dock, 5. See also showing/hiding

aliases on, 90-91
applications, launching, 132
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customizing, 88-89
deleting

items, 89
stacks, 19

moving items from, 89
showing/hiding, 88

hidden Dock, displaying, 18
stacks, 19

Simple Finder, 94
stacks, 19

documents, 163. See also attachments;
Dictionary; faxing; HTML 

bulleted lists, adding, 184
character spacing, changing, 182
closing, 191
copying text, 167
corrections in, 170
creating, 164
deleting text, 166
different program, opening with, 29
editing text, 166-167
existing documents, opening, 165
file formats for, 164
files, adding, 189
finding/replacing text in, 176-177
formatting

copying/pasting, 187
text, 178

grammar-checking, 172-173
handwritten text, inserting, 168-169
hyphenation, setting, 181
icons, 10
images, adding, 189
inserting text, 166
line spacing, changing, 183
lists, adding, 184
Microsoft Word file, saving as, 164, 190
movies, adding, 189
moving text, 167
numbered lists, adding, 184
opening, 28-29
page breaks, inserting and deleting, 183
Page Setup options for, 204
paragraph indents, setting, 181
paragraph tabs, setting, 180
PDF files, saving as, 209
Plain Text files, saving as, 190-191

previewing printed documents, 208
protecting, 190
read-only files, saving documents, 190
recent documents, opening, 165
RTF file, saving document as, 164, 190
rulers, using, 179
selecting text in, 166
spacing

character spacing, changing, 182
line spacing, changing, 183

speaking text in, 175
special characters, inserting, 188
spell-checking, 172-173
styles, applying, 186-187
tables, adding, 184-185
text wrap, changing, 181
typing errors, correcting, 170
undoing/redoing actions in, 170
viewing, 28-29
Web page, opening, 230-231

Documents folder, 28-29
dots per inch (dpi), 196
double-clicking with mouse, 6
downloading. See also iTunes; Safari

Acrobat Reader, 209
deleting downloaded file, 251
disk images, 251
iChat versions, 291
installing downloaded applications, 131
MobileMe services backup, 358
printer drivers, 197
software, 432
stopping downloading of file, 251
widgets, 156

Downloads folder, 28-29
Downloads window

clearing settings, 256
working with files in, 250-251

dpi (dots per inch), 196
drag-and-drop

document text, moving/copying, 167
files and folders, copying/moving, 45

dragging
aliases, 91
with mouse, 6

drivers for printers, 197
Drop Box folder in Home folder, 47, 402
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DSL (digital subscriber line), 220
Ethernet with, 223
sharing connection, 408

DVD Player, 130, 313
browsing movies with, 332
customizing, 333
key points, creating, 333
playing movies with, 332

DVD-R and DVD-RWs, 27, 52
DVDs, 27. See also iDVD

adding/removing files/folders from, 53
backing up files on, 490
creating, 53
disk image, burning from, 488
erasing, 338
preparing to burn, 52
start settings, changing, 113
System Profiler, viewing information

with, 447
uneven DVDs, loading, 27

E
editing

Address Book contact information, 140-
141

color labels, 40
documents, text in, 166
keychains, 382-383
Smart folders, 70-71

Edit menu Undo/Redo commands, 43
editing movies, 336-337
ejecting disks, 16, 54

desktop icon, 5
ellipses (...)

full text, showing, 34
in menus, 7

e-mail. See also Mail
MobileMe mail, 348-349

embedding movies and images, 189
emoticons in instant messages, 300-301
empty Trash warning, turning on/off, 49, 81
encryption

FireVault using, 397
Keychain data, 384

entry fields in dialogs, 9
EPS (Encapsulated PostScript) files, 150
erasing CDs/DVDs, 338

Esc key, 9
ESPN, Dashboard displaying, 158-159
Ethernet. See also AirPort

configuring connection, 220
for LANs, 410
networks, 220
setting up connection, 223

Eudora mail, importing, 259
example workflow. See Automator
exporting. See importing/exporting
Exposé, 20

copying items with, 45
customizing, 92
Dashboard preferences, changing, 157
moving and copying files with, 45
space with, 21

external disks, 27

F
Fast User Switching, enabling, 396
favorites

folder, 29
style favorites, applying, 186-187

faxing, 195
Address Book, addressing faxes from,

214, 218
automatically receiving faxes, 216-217
cover pages, creating, 207, 213
receiving faxes, 216-217
scheduling faxes, 217
sending fax documents, 214-215
sleep mode, turning off, 216-217
status of fax, checking, 217

Feedback window for speech recognition,
116-117

file extensions
different program, opening documents

with, 29
for document files, 164
Find window searching, 66
renaming files, effect of, 43
showing/hiding, 81

File Info window, 390
file management, 25
file permissions

for copying and moving files, 45
setting, 390
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files, 1. See also aliases; Exposé; file 
permissions; Home folder; iDisk;
naming/renaming

arranging files, options for, 33
Bluetooth, moving with, 414
colors, organization by, 40
Column view, working in, 37
compressing, 33
copying, 44-45
Cover Flow, viewing with, 36
deleting, 48
documents, adding to, 189
e-mail as file, saving, 282
Icon view, viewing in, 32-33
Info window, information in, 50-51
instant messages, sending with, 303
kind

arrangement of files by, 33
Find window search for files by, 67

List view, working in, 34-35
moving, 44-45
Network Sharing Services, 404, 406-407
Quick Look, viewing in, 38
recently used files, opening, 133
restoring deleted files, 48-49
sorting by column, 35
Stationery Pad, 50-51

File Transfers manager in iChat, 303
filters. See also Quartz Filters

Spotlight results, filtering, 60
viewing information on, 459

Final Cut Pro, 334-335
Finder, 1. See also CDs; DVDs; Finder

Preferences; indexing
Application Services with, 436
Automator workflow from, 506
Help menu, 74
icon views, customizing, 82
introduction to, 4-5
mouse pointer in, 6
networks, browsing, 416-417
Simple Finder, 94
Spotlight results in, 63
toolbar, customizing, 84-85
undoing actions in, 43
window opening, customizing, 80

Finder Preferences, 26, 77
Advanced preferences pane, 78

description of, 78
file extensions, showing/hiding, 81
General preferences pane, 78
icons on desktop, specifying, 79
Label preferences pane, 78
Sidebar preferences pane, 78
spring-loaded folders, turning on/off, 46

finding/replacing
documents, text in, 176-177
Wrap Around option, 176-177

Find window
files, searching for, 66-67
hard to find information, searching 

for, 68
naming/renaming

files, 69
searches by name, 67

results, working with, 69
Finger service, 430
FireVault

Home folder, protecting, 397, 401
passwords with, 401
turning on/off, 397

firewalls, 221
configuring, 409
printers, sharing, 202-203

FireWire, 54
flash drives, 27
Flight tracker, Dashboard display, 158-159
folders, 25. See also aliases; Exposé; iDisk;

naming/renaming; Smart folders;
spring-loaded folders

arranging folders, options for, 33
Automator workflow from, 506
bookmarks folder, creating, 238
colors, organization by, 40

folders
Column view, working in, 37
compressing, 33
copying, 44-45
creating, 42
deleting, 48
icons, 10
Icon view, viewing in, 32-33
Info window, information in, 50-51
kind

arrangement of files by, 33
Find window search for files by, 67
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folders (continued)
List view, working in, 34-35
moving, 44-45
Quick Look, viewing in, 38
Recent Folders list, 39
restoring deleted folders, 48-49
Safari bookmarks, creating folder, 238
sorting by column, 35
Spotlight searches, keywords for, 57
types of, 26-27

Font Book, 129, 130
activating/deactivating fonts, 154
customizing fonts, 154-155
managing fonts with, 153

fonts
defined, 178
for document text, 178
for e-mail message text, 269
for iChat chats, 310
for instant message text, 300-301
locating, 155
on-screen smoothing, 455
Safari font preferences, setting, 253
size, 178
smoothing styles, changing, 100-101
Spotlight searches, keywords for, 57
TextEdit preferences, setting, 194

forcing a restart, 448
foreign languages. See languages
formatting. See also documents

copying/pasting, 187
disks, 438
e-mail message text, 269
instant message text, 300-301
international options, changing, 106-107
TextEdit preferences, setting, 194

forms, filling out, 242-243
Forward button on toolbar, 17
forwarding e-mail, 274-275
frames, 227

printing Web page frame, 246
Front Row, 130, 313

changing settings in, 341
media, viewing, 340
navigating and starting, 339
playing, 114

full-screen interface with DVD Player, 333

G
gestures

Ink Pad recognizing, 169
turning on/off, 128

Get Info button, 69
Get Info dialog box, 63
G5 architecture, 462
Gmail calendar account, 366
Go menu, 39
Google

Address Book from, 141
Application Services with, 436
clearing search settings, 256
Dashboard displaying, 158-159
iCal calendar account, 366
iChat, Google Talk with, 289, 290
Search box, 244-245

Grab, 436
screen shots, capturing, 149

Gracenote music title repository, 327
grammar checking. See spell and grammar

checking
Grapher, creating graphs with, 145
graphics. See also images

Quartz Extreme enhanced graphics, 102
RTFD files for, 164

grid settings, overriding, 33
grouping/ungrouping

iCal, creating calendar groups, 368-369
iChat buddy groups, managing, 298-299
Spotlight results, 62

GUI (graphic user interface), 1, 452
.gzip files, 251
opening, 434

H
hackers, firewalls and, 409
handwriting

documents, inserting handwritten text
in, 168-169

Chinese, in, 169
ink preferences, setting, 128

hard drive, 27. See also disk file system
Find window searching, 66
Info window, information in, 50-51
optimizing, 441
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System Profiler, viewing information
with, 447

Web page, opening, 230-231
hard to find information, searching for, 68
hardware, 449

ColorSync, matching colors to device
with, 458-459

compatibility, checking for, 462
installing devices, 450
for Mac for Windows, 466
preferences, 96

viewing, 451
problems, preventing, 462-463
removing devices, 464
Safe boot, performing, 463
settings, viewing, 451

hearing impaired users, preferences, 120
help

Assist Me, help with, 407
browsing for, 74-75
for iChat, 74, 292
for Internet connection, 221
MobileMe services online support, 364
searching for, 74-75
with Spotlight, 76
VoiceOver help, 123

hexadecimal color values, 456
highlight colors, 100
History list. See Safari
Home folder, 28-29, 388

desktop, opening from, 29
Drop Box folder, 47, 402
Find window searching, 66
FireVault protecting, 397, 401
managing files with, 400
Public folder, 28-29, 47, 402
Shared folder, 47, 402
Sites folder, 402

Home page. See Safari
hot spots, VoiceOver, 123, 126
HotSync reminder, 377
HTML (Hypertext Markup Language)

Dashcode, 162
documents in, 164
links to HTML files, adding, 193
opening HTML documents, 192
plain HTML code files, creating, 192-193

TextEdit, creating HTML documents
with, 192-193

Web page code, viewing, 248
HTTP (Hyper-Text Transfer Protocol), 231
hubs for LANs, 410
hyperlinks. See links
hyphenation, setting, 181

I
iBook sleeping options, 110
iCal, 130. See also iSync

adding calendar accounts, 366
adding calendar events, 370
attachments for event, working with, 370
Automator workflow from, 506
backing up calendar, 371
creating calendars with, 368-369
Dashboard displaying, 158-159
deleting events, 370
details of event, editing, 371
To Do lists

creating, 367
printing, 374

editing calendar events, 370-371
groups in calendar, creating, 368-369
importing/exporting events, 370
preferences, changing, 369
printing calendar and To Do lists, 374
publishing calendar, 372
restoring calendar, 371
shared calendars, finding, 372
Spotlight searches, keywords for, 57
subscribing to calendar, 372-373
viewing window, 366

iChat, 129, 130, 289, 343. See also Bonjour
accounts, creating, 290-291
adding buddies, 296
with AirPort, 308
alerts, setting, 312
animated GIF, creating, 297
appearance of chat, changing, 310
Application Services with, 436
audio chats, 304

enhancing, 306
automatically reopening chats, 311
away messages, 294
backdrops, adding, 306
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iChat (continued)
background of window, changing, 311
bandwidth speed for video chats, 

changing, 304-305
blocking buddies, 302
collecting chats in single window, 301
custom status messages, creating, 294
deleting

buddies, 296
groups of buddies, 299

downloading versions of, 291
e-mail, responding to, 274
emoticons, inserting, 300-301
files with message, sending, 303
formatting message text, 300-301
groups of buddies, managing, 298-299
help in, 74, 292
links with messages, sending, 303
notification alerts, 312
parental controls for, 392-393
passwords for, 291
performance and quality specs, 305
Photo Booth

effects, adding, 306
video clips in, 330

pictures
of buddies, 297
theater presentations, 306-307
of video chats, 305

receiving instant messages, 300
recording video chats, 307
renaming buddy groups, 299
sending instant messages, 300
sharing screens, 309
signing in and out, starting, 292
status, changing, 294
Status menu, using, 294-295
text, viewing chat as, 311
theater presentations, hosting, 306-307
turning on/off

groups, use of, 298
Status menu, 295

video chats, 304
backdrops, adding, 306
bandwidth speed, changing, 304-305
enhancing, 306
installing hardware for, 291
monitoring, 305

Photo Book effects, adding, 306
pictures of, 305
recording, 307
theater presentations, 306-307

viewing window, 293
view of buddy list, changing, 299

icons. See alsoTrash
copying, 10-11
customizing views of, 82-83
deselecting, 10-11
on desktop, 4
disk icons, displaying, 27
Finder Preferences for displaying, 79
moving, 10-11
selecting, 10
Sidebar, removing icon from, 16
for Spotlight, 55

Icon view, 30
arranging items in, 32-33
customizing window views, 82-83
spring-loaded folders, opening, 46

iDisk, 16, 343-344
backing up files to, 479
displaying files from, 359
managing files with, 358
passwords, changing, 363
preferences, setting, 360-361
Public folder, 359, 362

permissions, changing, 363
sharing, 362-363

iDVD, 52
exploring, 342

iListen, 118
Image Bar with DVD Player, 333
Image Capture, 130

Automator workflow from, 506
working with, 148

images. See also attachments
Address Book, adding images to, 144
documents, adding to, 189
iChat buddy picture, changing, 297
previewing, 150-151
Safari, saving Web page images in, 249
Spotlight searches, keywords for, 57

IMAP (Internet Messages Access Protocol),
261

mailboxes for, 279
iMovie, 342
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Import Bookmarks command, 237
Import Image command, 436
importing/exporting. See also iTunes

Address Book contacts, importing, 139
animated GIF, exporting movie as, 331
Automator workflows, 503
iCal events, 370
iTunes, music from CDs to, 317
mailboxes to Mail, 259
MP3 players, exporting music to, 326
QuickTime, exporting movies, 336-337

Inbox. See Mail
indents

documents, 181
for e-mail message text, 269

indexing, 55
Info window options, 51
search, files for, 67

Info window
file information on, 50-51
options, setting, 51

infrared (IR) technology, 225, 313
ink-jet printers, 196
Ink Pad, 168
ink preferences, setting, 128
installing. See also uninstalling

Dashboard widgets, 160
hardware devices, 450
printers, 198
software, 432
third-party applications, 131
Windows on Mac, 468-469

instant messages, 289. See also Bonjour;
iChat

SMS (short message service) text, 308
Intel-based Mac computers. See Mac for

Windows
inter-line spacing, 183
international options, changing, 106-107
Internet, 219. See also AirPort; download-

ing; firewalls; wireless connections
Assist Me button, 221
connecting to, 220-221
hardware problems, checking on, 462
history of, 219
modems, setting up, 222
multiple connections, 221, 225

parental controls for, 392-393
searching, 244-245
security, 221
sharing connections, 221, 405, 408
songs, finding names of, 327
status menus for connecting to, 226

Internet Explorer, 219
Internet Radio, 313

iTunes window settings, 315
listening to, 323

iPhones with iTunes, 325
iPhoto, 52. See also Front Row

Automator example workflow for, 497
description of, 342
e-mail, adding photos to, 268

IP (Internet Protocol). See also printers
identifying address, 419
for ISPs (Internet service providers), 220
Sharing Service requiring, 404

iPod Hi-Fi, 313
iPods

Automator example workflow for, 497
disks, 27
with iTunes, 325
unmounting, 54

iSight, 129, 291. See also Photo Booth
with Mac for Windows, 465, 472

ISPs (Internet service providers), 220
attachments and, 276
Safari preferences, setting, 253

iSync, 130
adding devices to, 375
deleting devices from, 375
HotSync reminder with PDAs, 377
options for synchronization, setting, 376
preferences, setting, 377
Safari bookmarks, synching, 239

italicizing
document text, 178
e-mail message text, 269
fonts, 155

iTunes, 52, 130, 313. See also Front Row
aspects of iTunes, viewing, 319
automatically playing CDs with, 316
backing up library, 327
Boot Camp Assistant and, 465
copyright laws and, 321
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iTunes (continued)
Dashboard displaying, 158-159
downloading

from CDs, 317
from iTunes Music Store, 318-319

iMix, creating, 321
importing/exporting

CDs, music from, 317
MP3 players, exporting music to, 326
playlists, 320, 322

iPhones with, 325
iPods with, 325
with Mac for Windows, 472
minimizing window, 319
multiple libraries, creating, 317
playing music from CDs, 317
playlists

burning music CDs from, 326
creating, importing/exporting, 320-322
media, adding, 322
Smart Playlists, building, 320-321

podcasts, listening to, 324
preferences, setting, 328
radio list, adding stations to, 323
setting up, 314
Smart Playlists, building, 320-321
starting, 314
viewing window, 315
volume control for, 114

iTunes Mini Store, 314
iTunes Music Store, 315

iMix, creating, 321
using, 318-319

J
Jabber and iChat, 289, 290
Java, Safari enabling, 254
JavaScript

Dashcode, 162
Safari, enabling in, 254

joining MobileMe community, 344
Junior voice, 118
junk e-mail, 284-285
justification

of document text, 178
of tables, 185

K
kerning, changing, 182
keyboards

Calculator, using with, 146
changing settings, 453
international options, changing, 106-107
with Mac for Windows, 465, 472-473
Universal Access options, 120-121
VoiceOver help, 126

keyboard shortcuts, 7
applications, switching between, 135
customizing, 453
with DVD Player, 333
for Exposé, 92
Spotlight, setting for, 64-65
turning on, 9
with VoiceOver, 126

Keyboard Viewer, 106-107
Keychain

access controls, setting, 383
adding keychains, 384
description of, 380
modifying, saving keychains, 382-383
working with, 381

keywords
for Find window searches, 67
for Internet searches, 244
for Spotlight searches, 57

kilometer to miles conversions, 146-147

L
labels. See also color labels

Address Book labels, 138, 141
files and folders arranged by, 33

landscape orientation printing, 205, 206
languages

dictionary sources, 174
in documents, 165
Info window options, 51
international options, changing, 106-107

LANs (local area networks). See also AirPort
Ethernet connection for, 223
iChat with, 308
setting up, 410
with Sharing Service, 404
Windows Vista computers, connecting

from, 425
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Windows XP computers, connecting
from, 426-427

laser printers, 196
layout

for fax documents, 215
for printing, 207

left-alignment
of document text, 178
of tables, 184

left indent marker, 181
libraries. See iTunes
Library folder, 26-29
Library pane on Automator window, 492
Light Tunnel effect, 331
line height/spacing, changing, 183
links

e-mail message, sending links in, 276
to HTML code files, 193
instant messages, sending with, 303

lists. See bulleted lists; numbered lists
List view, 30

color labels, sorting files and folders, 40
customizing window views, 82-83
rearranging, widening columns in, 35
showing/hiding folders in, 34
sorting files and folders in, 35-36
spring-loaded folders, opening, 46

local disk, 27
locking/unlocking preferences, 99
logging in, 1

items, specifying, 394
with Network Sharing Services, 405

logging out, 23
Login window, 2

actions from, 3
activating, 387
bypassing, 3

lowering characters, 182
LTP Over IPsec protocol, 428

M
MacBinary format, 251
MacBook OS X DVD, keeping, 399
Mac Finder. See Finder
Mac for Windows, 465. See also Boot Camp

Assistant
installing Windows on Mac, 468-469

multiple internal disks, removing
Windows from computer with, 474

preparing, 466-467
removing Windows, 474-475
starting after installation of, 470-471
using Windows on Mac, 472-473

Mac OS X, 478
applications, list of, 130
CD, restoring passwords with, 399
MacBook OS X DVD, keeping, 399
restarting with, 112
Time Machine for reverting to previous

version, 484-485
Windows files, copying, 472-473

Mail, 130, 257. See also Address Book;
attachments

accounts
adding, 261
advanced options, setting, 263
managing, 262-263
setting up, 258, 260

addressing e-mail, 266-267
advanced account options, setting, 263
Application Services with, 436
archiving e-mail, 281
authentication of, 263
backing up e-mail, 281
BCc address field, 265
blocking e-mail, 284-285
bouncing e-mail, 284-285
Cc field, 266
composing e-mail, 265
data detectors, managing information

with, 268
dates and times, setting, 104
deleting, 280-281

options, changing, 281
diverting incoming e-mail to mailboxes,

285
To Do items, tracking, 271
draft e-mail, saving, 282
file, saving e-mail as, 282
formatting message text, 269
forwarding e-mail, 274-275
grammar-checking e-mail, 265
importing mailboxes and e-mail, 258-259
incoming e-mail, setting rules for, 286
instant message, replying to e-mail with,

274
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Mail (continued)
junk e-mail options, 284-285
links in e-mail message, sending, 276
mailboxes

for backing up e-mail, 281
diverting incoming e-mail to, 285
new mailbox, creating, 278
organizing e-mail in, 279
Smart Mailbox, creating, 287
standard mailboxes, 278

Message List view, changing, 273
new e-mail, checking for, 272
new mailbox, creating, 278
notes

creating, 271
searching for, 283

offline viewing, keeping copies for, 263
opening e-mail, 272-273
Out of Office message, creating, 286
parental controls for, 392-393
passwords for, 258, 263
photographs, adding, 268
preferences for addressing, 266-267
previous recipients list, sending e-mail

with, 266-267
printing e-mail, 281
priority to mail, adding, 265
quoted text in, 274
reading and receiving e-mail, 272-273
recovering deleted e-mail, 280
redirecting e-mail, 274-275
replying to, 274
resending messages, 285
RSS feeds, subscribing to, 288
rules, creating, 286
saving e-mail, 282
searching e-mail for text, 283
sending e-mail, 265
servers, 260-261

removing mail from, 263
signatures, creating, 270
Smart Addresses, using, 266
Smart Mailbox, creating, 287
sorting messages, 279
speaking voice, adding, 268
spell-checking e-mail, 265
Spotlight searches, keywords for, 57
starting, 258

stationery, adding, 268
threads, sorting e-mail by, 279
to-do tasks

searching for, 283
tracking, 271

Trash mailbox, 278
window, viewing, 264

maintaining computer, 431
master password, restoring, 398-399
maximizing/minimizing

changing options, 100
Dock, 88
iTunes window, minimizing, 319
slowing minimization, 89

media
Front Row, viewing in, 340
iTunes playlists, adding to, 320, 322

Media browser for Automator workflows,
503

memory
calculation results, saving, 147
Info window options, 51
system memory, viewing, 445

menu bar, 5
Bluetooth placed on, 413
clock, using, 105
Displays icon on, 454
rearranging status icons on, 8
status of fax, showing, 217

menus
contextual menus, 8
language options, setting, 106-107
pull-down menus, 8
working with, 7

metadata, 55
specific metadata, searching for, 68
Spotlight, finding information with, 56

microphones with iChat, 304
Microsoft. See also Mac for Windows;

Microsoft Word; Windows Vista;
Windows XP

Excel, Address Book for faxes with, 218
Exchange 2007 

calendar, 366
Mail server, 260

Internet Explorer, 219, 227
Outlook/Outlook Express, importing e-

mail to, 259
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Microsoft Word
Address Book for faxes with, 218
documents as files, 164, 190
formatting text in documents, 178
opening documents in, 29
Page Setup options, 204-205

MIDI
devices, configuring, 460-461

Mighty Mouse. See Apple Mighty Mouse
MiniDV camcorders with iMovie, 342
Minimize button for windows, 12, 15
mini restarts, 448
MobileMe, 343. See also iDisk; iSync

accessing account, 345
Address Book, 350-351
backing up files with, 358-359
calendar, adding, 352

events, 353
preferences, 353

connecting to computer with, 420-421
e-mail, managing, 348-349
gallery, 354-357

creating and modifying, 354-355
viewing and sharing, 356-357

iDisk, sharing, 362-363
joining MobileMe community, 344
Mail services, 348-349
online support, obtaining, 364
preferences for account, changing, 

346-347
signing on to, 345

MobileMe synchronization
resetting, 379
setting up, 378

modems, 220. See also cable modems
configuring connection, 220
setting up connection, 222

monitors. See also colors
display settings, changing, 454-455
fonts on screen, smoothing, 455

mounting disks, 54
mouse. See also Apple Mighty Mouse

changing settings, 452
pointer, 6
Universal Access options, 120-121
windows, resizing, 15
working with, 6

Mouse Keys, 120-121

movies. See videos
Movies folder, 28-29
moving. See also drag-and-drop; navigating

Address Book contacts, 140
Bluetooth, items with, 414
Dock items, 89
documents, text in, 167
with Exposé, 45
files and folders, 44-45
icons, 10-11
Mailboxes on screen, 279
Safari, bookmarks in, 237
Sidebar, moving folders with, 16
spaces, window between, 21
windows, 14

MP3 players, exporting music to, 326-327
MR (Memory Recall) button, 147
multi-function devices, 196
music, 313. See also CDs; Front Row;

iTunes; MIDI
finding names of songs, 327
Spotlight searches, keywords for, 57

Music folder, 28-29
muting sounds, 114

N
naming/renaming. See also Find window;

Keychain
color label names, changing, 41
files and folders, 42-43

arranging by names, 33
iChat buddy groups, 299
Info window options, 51
Mailboxes, 279
Safari Bookmarks Library collection, 239
user accounts, short name for, 388

Nature Background, 102
navigating

in dialogs, 9
Front Row, 339
with VoiceOver, 123, 124
Web pages, 230-231

nesting tables, 185
Netscape Navigator, 219, 227

Mail, importing e-mail to, 259
NetStat, 430
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network disks, 27
Info window, information in, 50-51

Network Preferences pane, connecting to
Internet with, 226

network printers, 202-203
accessing shared printers, 202-203
installing, 198

networks, 403. See also AirPort; Bluetooth;
LANs (local area networks); network
printers; Network Sharing Service

activity, viewing, 445
Bonjour messaging on, 289
Finder, browsing with, 416-417
other computers, connecting to, 418-419
port configuration, 225
privileges for users and groups, creat-

ing, 406
searching for files on, 417
several computers, connecting to, 418
Sidebar, accessing from, 417
System Profiler, viewing system infor-

mation with, 447
utilities, 430
VPN (Virtual Private Network), VLAN

(Virtual Local Network), connecting
with, 428-429

Windows, sharing Mac files with, 424
Network Sharing Service, 404-405

file sharing, setting up, 406-407
Internet Sharing, 408

Network Utility, 430
New dialog box, 496
no access for network users, 406
nonresponding applications, quitting, 136
notes. See also Mail; Sticky Notes

Keychain, adding secure notes with, 381
NOT operator, searching with, 57
NPR, listening to, 323
NSFNET, 219
NTFS, reformatting with, 468
NTSC format with iMovie, 342
numbered lists, 184

in e-mail message text, 269
numbering

international options, changing, 106-107
recent items, changing numbering of,

100-101
NumPad Commander, 123, 125

O
online support from MobileMe, 364
Open dialog box in Automator, 496
opening

applications, 133
Dashboard, 156
disks, 26-27
documents, 28-29
Info window options, 51
recent applications and documents, 39
recently used applications, 133
Scripts menu, scripts from, 511
windows, 12-13

operating system, 1
optimizing hard drive, 441
Option buttons in dialogs, 9
orientation for printing, 205, 206
OR operator, searching with, 57
outlining

document text, 178
fonts, 155

Out of Office message, creating, 286

P
page breaks, inserting and deleting, 183
Page Setup

individual defaults, setting up, 205
for printers, 200
printing and range options, 204-206
for text wrap, 181

pages per minute (ppm), 196
PAL format with iMovie, 342
Palm OS devices. See PDAs (personal data

assistants)
panes. See also specific panes

working with, 7
paper feed for printing, 207
paper handling for fax documents, 215
paper size for printing, 200, 204, 206
paragraphs

indent markers, 181
spacing, 183

parental controls
for Dictionary, 175
logging activity with, 392
time limits, setting, 393
for user accounts, 391, 392-393
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partitioning disks, 467
passwords. See also Keychain

with FireVault, 397, 401
hints, adding, 388
for iChat, 291
iDisk passwords, changing, 363
for Internet connections, 220
for logging out, 23
from login window, 387
for MobileMe account, 346-347
for Mail, 258, 263
master password, restoring, 398-399
on shared computers, 3
in Simple Finder, 94
tips on creating, 398

Paste command, 44
pasting

Automator workflows, 503
formatting, 187
ruler, 179

PDAs. See also iSync
Bluetooth with, 412
networks with, 403

PDF files
documents as PDF files, saving, 209
downloading Acrobat Reader, 209
previewing, 150-151
Safari, viewing in, 247
Saving in, TextEdit, 190
Spotlight searches, keywords for, 57
working with, 151

pen cursors, 128
People, Dashboard displaying, 158-159
permissions. See also file permissions

for screen sharing, 422
phones. See cell phones
Photo Album, Automator example for, 497
Photo Booth, 130, 313. See also iChat

animated GIF, creating, 297
capturing photos in, 329
effects, adding, 331
proof sheets, 329
videos

effects, 306
recording, 330

Photo Browser, 268
photographs. See also Front Row

e-mail, inserting in, 268
iChat buddy picture, changing, 297

Photoshop Preview, opening files in, 150
pictures. See images
Pictures folder, 28-29
Ping service, 430
Pipe Organ voice, 118
Places section, Sidebar, 16
Plain Text Encoding pop-up, 165
Plain Text files

documents as Plain Text files, saving, 191
TextEdit preferences, setting, 194

playlists. See iTunes
plug-and-play devices, 450
plug-ins

Automator with, 499, 506
compatible plug-ins, checking, 255
Safari, enabling in, 254

podcasts. See also Front Row
listening to, 324

pointing with mouse, 6
POP (Post Office Protocol), 261
pop-up menus, 8

in dialogs, 9
on toolbar, 17

pop-up windows, blocking, 255
portrait orientation printing, 205, 206
PostScript files, 201

PDF file, converting to, 150
PowerBook/MacBook

sleeping options, 110
wireless connections, 224

power failure restart options, 110-111
power strips, 450
ppm (pages per minute), 196
PPoE (Point to Point Protocol over

Ethernet), 223
making connection with, 226

PPTP protocol, 428
preferences. See also Finder Preferences;

hardware; iChat; Safari; System
Preferences

Bluetooth preferences, setting, 415
Dictionary preferences, setting, 174-175
Dock preferences, setting, 88-89
iCal preferences, changing, 369
iDisk preferences, setting, 360-361
iSync preferences, setting, 377
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preferences (continued)
iTunes preferences, setting, 328
Language & Text, 106-109
MobileMe account preferences, chang-

ing, 346-347
Mail, addressing, 266-267
Sidebar preferences, changing, 86-87
Spotlight preferences, customizing, 64
TextEdit preferences, setting, 194
for Time Machine, 478
VoiceOver preferences, setting, 124-125

presentation keyword for Spotlight, 57
Preview, 130, 150-151
Preview column, Column view, 37
Preview File Open command, 150
previewing

dialogs, area in, 9
Info window options, 51
printed documents, 208
print image, 206

Print command, 206-207
printer drivers, 197
printers. See also Bonjour; network printers

adding or removing, 198-199
default settings, setting, 200
description of, 196
desktop printers, using, 210
IP (Internet Protocol)

for installing printers, 199
for sharing printers, 202-203

manually adding, 198-199
Network Sharing Services, 404
PostScript Printer Desc. (PPD) files, 201
sharing, 202-203, 404
Sharing Service, 404
specific settings, setting, 201

Printer Setup Utility, printer drivers in, 197
Printers folder, displaying printers in, 210
Print & Fax pane, 200-201
printing, 195

from Address Book, 141
Automator workflow, 505
basic print options, setting, 206-207
cover pages, creating, 207, 213
e-mail messages, 281
help topics, 75

iCal calendar and To Do lists, 374
Page Setup options, 204-205
previewing printed documents, 208
queues, managing, 210, 211
reverse order printing, 207
running print jobs, 212
saving print options, 215
scheduling jobs, 212
to shared printers, 203
two print jobs with two printers, 205
Web pages, 246

Print Queue utility, 210
privacy preference in Spotlight, 64-65
Private Browsing, 230
privileges for users and groups, 406
proof sheets in Photo Booth, 329
protocols, 261
proxies, 220
Public folder. See also iDisk

in Home folder, 28-29, 47, 402
publishing iCal calendar, 372
pull-down menus, 8
Push button in dialogs, 9

Q
Quartz Extreme enhanced graphics, 102
Quartz Filters

Automator example workflow for, 497
for fax documents, 216
for printed documents, 207

Quick Erase setting, 338
Quick Look

attachments, viewing, 276-277
toolbar button, 17
viewing files with, 38

QuickTime movies, 330
iMovie and, 342
streaming options, 334-335
in theater presentations, 307

QuickTime Player, 130, 313
creating and editing movies, 336-337
playing movies, 334-335
sharing movies, 336-337

quitting applications, 136
quoting text in e-mail, 274
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R
radio. See also Internet Radio

podcasts, listening to, 324
raising characters, 182
read and write permissions

for moving/copying files, 45
for network users, 406
in Shared folder, 47

read-only permissions
documents as read-only files, 190
for moving/copying files, 45
for network users, 406
in Public folder, 47

Recent Folders list, 39
recently used items

applications, opening, 133
documents, opening, 165
numbering, changing, 100-101

recording
AppleScripts, 510
Automator actions, 502
video chats, 307

recovering. See restoring
Redo command, 43
redoing. See undoing/redoing
refresh rate, setting, 454
registration symbol, inserting, 188
reloading Web pages, 230-231
removable disks, 27

Info window, information in, 50-51
Rendezvous Web sites, adding, 238
replacing. See finding/replacing
resizing. See size/resizing
resolution

monitor resolution, setting, 454
of printers, 196

restarting, 24
forcing a restart, 448
from Login window, 3
with Mac OS X, 112, 442
power failure restart options, 110-111
in Target Disk Mode, 112
Time Machine backup for, 481

restoring
calendar with iCal, 371
compressed files and folders, 436
deleted files and folders, 48-49

disk image, 489
e-mail, 280
master password, restoring, 398-399

Return key, 9
reverse order

fax documents, sending, 215
printing pages in, 207

RGB (Red, Green, Blue) colors, 456
right-alignment

of document text, 178
of tables, 184

right indent marker, 181
routers, 220, 408
RSS feeds. See also Safari

customizing, 240
Mail, subscribing in, 288
widgets and, 156

RTFD files, documents as, 164
RTF files

documents as, 164, 190
formatting text in, 178

rulers, showing/hiding, 179

S
Safari, 130

Address Book to Bookmarks bar, adding,
238-239

advanced preferences, setting, 253
alerts for nonsecure forms, 243
appearance preferences, setting, 253
AutoFill preferences, setting, 242
bookmarks, 228

creating and deleting pages, 237-239
folder, creating, 238
organizing, 239
for RSS feeds, 240-241
Spotlight searches, keywords for, 57
synching on multiple computers, 239
tabs, opening with, 232-233

Bookmarks Library, 237
deleting bookmarks in, 238-239
organizing bookmarks in, 239
renaming collection, 239

cache, emptying, 236
compressing/uncompressing disk

images, 251
cookies, preferences regarding, 254
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Safari (continued)
copying text from Web page, 249
customizing window, 228
default browser, selecting, 256
deleting

bookmarks, 238-239
History list entries, 236

different window, opening page in, 233
disk images, downloading, 251
downloading

files, downloading, 250-251
Home page, 252

Downloads window, working with files
in, 250-251

encoding preferences, setting, 253
font preference, setting, 253
forms, filling out, 242-243
general preferences, setting, 252
grammar-checking in, 243
help information in, 74
History list

clearing settings, 256
preferences, setting, 252
viewing, 236

Home page
changing, 235
going to, 230-231
preferences, setting, 252

HTML code, viewing, 248
navigating in, 230-231
nonworking Web pages, 255
opening Web pages in, 230
PDF files, viewing, 247
pictures from Web page, saving, 249
pop-up windows, blocking, 255
preferences

advanced preferences, 253
appearance preferences, 253
general preferences, 252
security preferences, setting, 254

printing Web pages, 246
reloading pages, 230-231
resetting settings for, 256
RSS feeds

bookmarking, 240-241
customizing, 240

saving
information in Web page, 248-249

text of Web page, 248
security

pop-up windows, blocking, 255
preferences, setting, 254

security preferences, setting, 254
size of text, changing, 233
SnapBack page, 245
spell-checking in, 243
starting application, 228
style sheet preferences, 253
synching bookmarks on computers, 239
tabs

opening Web page with, 232-233
setting browsing options for, 232

Top Sites, 234
viewing window, 229
Web Clip widgets, creating, 162

Safe boot, performing, 463
Samba server software, 424
Save As dialog box, 190
saving. See also Safari

attachments, files in, 277
Automator workflow, 505
Bonjour chats, 309
e-mail, 282
Keychain, changes in, 383
print options, 215
Smart folders, copy of, 71
Web page information, 248-249

scanner information, viewing, 447
scheduling. See also iCal

fax documents, 215
faxes, 217
print jobs, 207, 212

screen savers, setting up, 103
screen sharing

permissions, setting, 422
using, 423

screen shots, capturing, 149, 336-337
Script Editor, 510

Application Services with, 436
Script menus. See also AppleScripts

adding scripts to, 509
Automator workflow from, 506
displaying, 508
opening scripts from, 511

scroll bars
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changing action of, 100
options, changing, 100

search boxes
in Automator, 493, 494
on toolbar, 17
for windows, 12

search engines, 244-245
Search For section, 16

Smart folders, using, 72-73
searching. See also Dictionary;

finding/replacing; Find window;
Spotlight

Automator workflows, 503
e-mail for text, 283
for hard to find information, 68
for help, 74-75
Internet, 244-245
metadata searches, 68
network, files on, 417
with VoiceOver, 123

secret folder hierarchy menu, 39
security. See also Keychain; passwords;

Safari
Internet security, 221
for logging out, 23
for switching between users, 22-23
system security preferences, setting, 397

selecting
documents, text in, 166
icons, 10

Sepia effect, 331
servers. See also Mail

Find window searching, 66
Web Sharing service, 404

Shared folder in Home folder, 47, 402
Shared section, Sidebar, 16
sharing. See also network printers; Network

Sharing Service; screen sharing
Address Book, 138, 142-143
buddies, screens with, 309
Home folder, sharing files in, 402
iCal calendars, 372
iChat screens, 309
Internet connections, 221
Network Sharing Services, 404-405
printers, 202-203, 404
starting on shared computer, 2-3
widgets, 156

Windows, Mac files with, 424
Windows Vista computers, connecting

from, 425
Sharing Preferences, 404
shortcuts. See aliases; keyboard shortcuts
Show All command on Spotlight menu, 58
showing/hiding. See also Dock

applications, 134
Dashboard, widgets on, 158
with Exposé, 20
file extensions, 81
List view, folders in, 34
Mailbox list, 279
rulers, 179
Sidebar and toolbars, 16-17, 86

Show Inspector, 50
Show Modem Status menu, 222
Show View Options command, 32
shutting down, 24

from Login window, 3
options, setting, 110-111

Sidebar
customizing, 86-87
networks, accessing, 417
preferences, changing, 86-87
shared devices, displaying, 420
showing/hiding, 16, 17, 86
Smart folders, using, 72-73
using, 16
for windows, 12

sight impaired users, preferences, 120-121
signatures to e-mail, 270
Simple Finder, 94
Sites folder, 28-29

in Home folder, 402
size/resizing. See also compressing/uncom-

pressing
files and folders arranged by size, 33
Find window searches by size, 67
font size, 178
help text, 75
Web page text, 233
windows, 12, 14-15

Ski Report, Dashboard displaying, 158-159
sleep mode, 24

faxes, turning off to receive, 216-217
from Login window, 3
setting sleep options, 110-111
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slider in dialogs, 9
slideshows for Spotlight results, 63
Slow Keys, 120-121
Smart folders

changing search criteria for, 73
creating and editing, 70-71
saving copy of, 71
Sidebar, using in, 72-73

Smart Mailbox, creating, 287
Smart Playlists, building, 320-321
smart searches with VoiceOver, 123
SMB/CIFS

file services, 424
sharing printers with, 202-203

smileys in instant messages, 300-301
smoothing fonts on screen, 455
SMS (short message service) text, sending,

308
SMTP (Simple Mail Transfer Protocol), 261
SnapBack page, 245
Snap to Grid setting, 33
software. See also hardware

automating updates, 433
compatibility, checking for, 462
downloading, 432
installing, 432
removing hardware device software, 463
uninstalling, 48, 432

Solid Colors Background, 102
sorting

by color labels, 40-41
e-mail messages, 279
Find window file results, 69
List view, files and folders in, 34-35
Spotlight results, 62
widgets, 161
sounds. See also alerts; VoiceOver
changing sound effects, 114
dates and times, announcing, 105
in Front Row, 341
input options, setting, 115
MIDI devices, configuring, 460-461
output options, setting, 115
Spotlight searches, keywords for, 57

Spacebar with spring-loaded folders, 46
Spaces, 130

customizing, 93
Dashboard preferences, changing, 157

grouping windows into, 21
spacing

character spacing, changing, 182
line spacing, changing, 183

Speakable Commands window, 116
speaking voice. See also Alex; VoiceOver

document text, speaking, 175
for e-mail, 268
interface options, setting, 119

speech recognition, 116-117. See also Alex
with Address Book, 138, 141
Application Services with, 436
enabling, 117
for Sticky Notes, 152
using, 117

speed of printers, 196
spell and grammar checking, 163

adding words to dictionary, 172
for documents, 172-173
e-mail, 265
in Safari, 243
in Spotlight, 59

Spotlight, 55
backed-up items, recovering, 482-483
canceling search, 57
desktop icon, 5
e-mail, searching for, 283
filtering results, 60
finding information with, 56-57
grouping results, 62
help with, 76
keyboard shortcuts, setting, 64-65
keywords for searches, 57
metadata, finding information with, 57
preferences, setting, 64-65
privacy preferences, setting, 64-65
sorting results, 62
viewing results in window, 58-59
windows, working with, 58-59
working with results, 63

Spotlight Search box, 76
spring-loaded folders

customizing, 80
using, 46

stacks on Dock, 19
starting. See also restarting

Automator, 495
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Bonjour messaging, 309
CDs, changing start settings for, 113
DVDs, changing start settings for, 113
with Fast Startup Switch, 442
Front Row, 339
iChat, 292
iTunes, 314
Mac for Windows, 470-471
Mac OS 9 disk, starting from, 442
power failure restart options, 110-111
Safe boot, performing, 463
specifying startup items, 394-395
stand-alone computer, 2

Startup commands, 395, 399
startup disk, 26-27

selecting, 112
Startup Disk Control Panel, 112
stationery for e-mail, 268
Stationery Pad in Info window, 50-51
status bar

in Safari, 228
for windows, 12

status menus
in iChat, 294-295
Internet, connecting to, 226

Sticky Keys, 120-121
Sticky Notes, 130

Application Services with, 436
creating, 152
Dashboard displaying, 158-159

Stocks, Dashboard displaying, 158-159
Stuffit Expander, 33, 131, 434
styles

deleting style favorites, 186-187
documents, applying to, 186-187
favorite styles, applying, 186-187
for fonts, 155
Safari style sheets, 253
toolbar styles, changing, 85

submenus, 8
subnet masks, 220
subscribing

to Address Book, 143
to iCal calendar, 372-373
to podcasts, 324
to RSS feeds, 288

subscript characters, 182

summary
of Application Services, 436
of printer options, 207

superscript characters, 182
surge protectors, 450
switching

between applications, 134-135
between Dock applications, 18
Fast User Switching, enabling, 396
between help libraries, 74
between users, 22-23
between windows, 14

symbols. See also copyrights; trademarks 
registration symbol, inserting, 188

synchronization. See also iSync; MobileMe
synchronization

of Address Book, 138
Safari bookmarks on multiple 

computers, 239
System Administrator. See Administrator
System folder, 26-27
System Preferences, 95. See also hardware;

monitors; QuickTime movies;
VoiceOver

appearance options, changing, 100-101
Bluetooth preferences, setting, 415
dates and times, setting, 104-105
description of, 96-97
desktop backgrounds, changing, 102
ink preferences, setting, 128
international options, changing, 106-107
Internet preferences, list of, 96-97
keyboard settings, changing, 453
language & text options, 171, 172
locking/unlocking, 99
mouse settings, changing, 452
network preferences, list of, 96-97
overall preferences, list of, 97
personal preferences, list of, 96
Print & Fax pane, 200-201, 202-203
screen savers, setting up, 103
Security pane, 397
sleeping options, setting, 110-111
sounds, controlling, 114-115
speaking voice, setting, 118-119
speech recognition options, 116-117
Spotlight searches, keywords for, 57
Startup disk, selecting, 112
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System Preferences (continued)
Universal Access preferences, 120-121
viewing, 98

System Profiler, viewing system informa-
tion with, 447

system recovery with Time Machine, 484

T
tab bars in Safari, 228
tables

cells, 184-185
documents, adding to, 184-185
merging cells in, 185
nesting tables, 185

tabs. See also Safari
in dialogs, 9
paragraph tabs, setting, 180

tab stops, setting, 180
tactile feel of keyboard, 453
Take Video Snapshot button, 144
.tar files, opening, 434
Target Disk Mode, restarting computer, 112
TCP/IP, 422

for modems, 222
telephones. See cell phones
television podcasts, listening to, 324
text. See also documents; Mail

encoding, selecting, 228
iChat chat as text, viewing, 311
in Safari, 228
substitution, preferences, 108-109

TextEdit, 29, 130, 163. See also documents
Application Services with, 436
automatic opening documents in, 81
Page Setup options, 204-205
preferences, setting, 194
speaking text in, 175
for Web design, 192-193

text substitution, 108-109, 171
text wrap

changing, 181
TextEdit preferences, setting, 194

theater presentations, hosting, 306-307
thesaurus, 174
third-party applications. See also software

installing, 131
System Preferences, 97

threads, sorting e-mail by, 279
Time Capsule, 478, 481
Time Machine, 130, 477

entire computer system, recovering, 484
excluding items from backup, 480
preferences, setting up, 478
previous version of Mac OS X, reverting

to, 484-485
recovering backed-up items, 482-483
restarting backup, 481
setting up, 478
starting manual back up, 479
system, recovering, 484-485
working with backup, 481

time management. See iCal
times. See dates and times
time zones, setting, 104
title bars

aliases, creating, 91
for windows, 12

To Do lists. See also Mail
iCal, creating with, 367

Toolbar Control button, 12
toolbars. See also Automator

adding icons to, 85
customizing, 84-85
deleting icons from, 85
Finder toolbar, customizing, 84-85
parts of, 17
rearranging icons on, 85
in Safari, 228
showing/hiding, 16, 17
styles for, 85
for windows, 12
working with, 7

trademark symbols
documents, inserting in, 188

Translation, Dashboard displaying, 158-159
Trash, 10

empty Trash warning, turning on/off, 49,
81

files and folders in, 48
securely deleting files and folders, 49
software, uninstalling, 48, 432
uninstalling software with, 48, 432

troubleshooting
Bonjour problems, 308
disk problems, 440
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hardware problems, 462-463
Safe boot, performing, 463

turning on/off. See also iChat
Bonjour, 308
Dock hiding, 18
empty Trash warning, 49, 81
FireVault, 397
Front Row settings, 341
gestures, 128
keyboard shortcuts, 9
spring-loaded folders, 46

U
underlining

document text, 178
e-mail message text, 269
fonts, 155

Undo command, 43
undoing/redoing

Address Book mistakes, 141
documents, actions in, 170
file deletions, 49
in Finder, 43
ink recognizing, 128

Unicode for languages, 165
uninstalling

hardware, 464
software, 48, 432

Unit Converter, Dashboard display, 158-159
Universal Access, 120-121. See also

VoiceOver
Automator actions and, 502

UNIX compressed files, opening, 434
unmounting networks, 54
updating

automating software updates, 433
from Boot Camp beta, 467
widgets, 157

up/down arrows in dialogs, 9
URLs (Uniform Resource Locators), 230

Application Services with, 436
home page, typing address for, 235

user accounts, 386
access privileges, setting, 391
adding, 388
deleting, 389
Fast User Switching, enabling, 396

file permissions, setting, 390
parental controls, setting, 391, 392-393
short name for, 388

user names for Internet connections, 220
Users folder, 28-29
Utilities folder, 489

V
Variable list on Automator window, 492-

493, 494
vCards, 139, 142-143

in attachments, 276
e-mail, including with, 270

verbosity preferences, setting, 124
video cameras, 291
videos. See also DVD Player; Front Row;

iChat; Photo Booth; QuickTime
movies; QuickTime Player

animated GIF, exporting movie as, 331
Dashboard displaying, 158-159
documents, adding to, 189
iMovie, 342
Spotlight searches, keywords for, 57

View buttons on toolbar, 17
views and viewing. See also specific views

changing window views, 30-31
customizing views, 30
disks, viewing, 26-27
documents, viewing, 28-29
hardware settings, 451
iCal window, 366
iTunes window, 315
System Preferences, 98

Virtual Network Computing (VNC), 422
visible files, searching for, 67
VoiceOver, 120

Braille, support for, 122, 125
commands, using, 126-127
description of, 122-123
hot spots, 123, 126
keys for, 123
preferences, setting, 124-125
searches and utility, 123

VO keys, 123
volume. See sounds
Volume desktop icon, 5
VPN (Virtual Private Network), 428
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VLAN (Virtual Local Area Network), 429

W
Wacom for handwriting recognition, 168
waking up options, setting, 110-111
Watch Me Do action, 502
Weather, Dashboard displaying, 158-159
Web addresses. See URLs (Uniform

Resource Locators)
Web browsers, 227. See also Safari

default browser, selecting, 256
history of, 219
Mail, starting, 259

Web Clips widget, creating, 162
Web pages. See also HomePage; RSS

feeds; Safari
copying text from, 249
different window, opening page in, 233
Image Capture, building with, 148
navigating, 230-231
nonworking Web pages, 255
printing, 246
reloading, 230-231
saving, 248
searching within, 244-245
size of text, changing, 233

Web sites, 227. See also HomePage; Web
pages

for printer driver downloads, 197
Whois service, 430
widgets, 156. See also Dashboard
Wikipedia, 174
windows, 1

activating, 12-13
Column view opening new windows, 37
Exposé, using, 20
Finder Preferences for customizing, 80
mouse, resizing with, 15
opening/closing, moving, 12-14
sizing/resizing, 12, 14-15
spaces, grouping windows into, 21
switching between, 14
TextEdit preferences, setting, 194
views, changing, 30-31

Windows Media
Boot Camp Assistant and, 465
with Mac for Windows, 472

Windows 7 or Vista. See also Mac for
Windows

LANs, connecting to, 425
upgrading Windows XP to, 468

Windows XP. See also Mac for Windows
LANs, connecting to, 426-427
outside network, connecting, 426-427
upgrading to Windows Vista, 468

WinZip, opening files compressed by, 434
wireless connections, 220. See also AirPort;

Bluetooth
infrared technology, 225

WordPerfect Page Setup options, 204-205
workflow. See Automator
World Clock, displaying, 158-159
write-only permissions for net users, 406
WYSIWYG, 208

X
X-Ray effect, 331

Y
Yahoo calendar account, 366

Z
Zoom button, 12, 15
zooming in/out

with DVD Player, 333
in Preview, 151
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